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I it Print
This printer supports Exif 2.2 (also called “Exif Print").
Exif Print is astandard for enhancing the communication between digital cameras and printers. By
connecting to an Exif Print-compliant digital camera, the camera’simage data at the time of shooting is
used and optimized, yielding extremely high quality prints.

I C:nadian Radio | nterference Regulations
This digital apparatus does not exceed the Class B limits for radio noise emissions from adigital appa-
ratus as set out in the interference-causing equipment standard entitled “Digital Apparatus,” ICES-003
of the Industry Canada.

Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux appareils
numériques de Classe B prescrites dans la norme sur le matériel brouilleur NMB-003 d'Industrie
Canadaintitulée « Appareils numériques ».

I | ntcrnational ENERGY STAR® Program
Asan ENERGY STAR® Partner, Canon Inc. has determined that this product meets the ENERGY
STAR guidelinesfor efficiency.

The International ENERGY STAR® Office Equipment Program is aglobal program
/\ that promotes energy saving through the use of computer and other office equipment.
W The program backs the development and dissemination of products with functions

that effectively reduce energy consumption. It is an open system in which business

can participate voluntarily. The targeted products are office equipment such as com-

puters, monitors, printers, faxes and copiers.

Their standards and logos are uniform among participating nations.

I Fover Requirements
Never use a power supply voltage other than that supplied in the country of purchase. Using the incor-
rect voltage could cause afire or eectric shock. The correct power supply voltages and frequencies are

asfollows:
Europe AC 230V+10%, 50Hz
USA/Canada  AC 120V, 60Hz
Austraia AC 240V, 50Hz

Printer Model: K10221 (i1950)



Preface
Shipping Materials

Thank you for purchasing a Canon Bubble Jet Printer.
Check that all the following items are in the box. If anything is missing or is damaged, contact your Canon
Authorized Dedler or Sales Representative.

A Printer

O Setup Software & User’'s Guide CD-ROM
O Quick Start Guide

Q Print Head

Q6 Ink Tanks

* Cables should be purchased separately according to your computer. For details on cable type and
specifications, refer to page 2.

Introduction

This Quick Start Guide uses the following symbols to indicate important information. Always observe the
instructionsindicated by these symbols.

Instructions that, if ignored, could result in death or serious personal injury caused by incorrect
operation of the equipment. These must be observed for safe operation.

Instructionsthat, if ignored, could result in personal injury or material damage caused by incorrect
operation of the equipment. These must be observed for safe operation.

Also read the Safety Precautionsin the User’s Guide. Observe the warnings and cautions to avoid
personal injury or damage to the printer.

/Trad emark Notices

« Canon® is aregistered trademark of Canon Inc.

« BJ" isatrademark of Canon Inc.

+ Microsoft® and Windows® are registered trademarks of Microsoft Corporation in the U.S. and other
countries.

» Apple, Mac, Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other
countries.

« All other trademarks and registered trademarks appearing in this Quick Start Guide are the property of
their respective owners.

Copyright ©2002 CANON INC.
All rights reserved. No part of this publication may be transmitted or copied in any form whatsoever
\Without the express written permission.




Setting Up

1 Preparing the Printer
1 Place the printer on a flat surface.

2 Remove the tape and the shipping
material from the printer as shown.

The tape position is subject to change.

2 Connecting the Printer to the Computer

USB cable

Recommended: Canon or other computer
manufacturer cable, up to 3 metersin length.

= Notes

« |f your computer has an earth connection, make sure that thisis attached.
« If you do not intend to use the printer for along period of time, unplug the power cord from the
power outlet after turning off the printer.




Follow the steps below to install the printer driver
correctly.

1 Ensure the printer and the computer are
switched off.

2 Connect the cable.

= Note

If the Add New Hardware Wizard or Found New Hardware
Wizard screen appears when carrying out the following
operations, click Cancel and turn off the computer.

Found New Hardware Wizard

‘Welcome to the Found New
Hardware Wizard

This wizard helps you nstal software for

(), 18 your hardware came wi
S or floppy disk. insert it now.




3 Installing the Print Head

» Never attempt to plug the power cord into the power outlet or unplug the power cord when your
hands are wet.

« Never damage, modify, stretch, or excessively bend or twist the power cord. Do not place heavy
objects on the power cord.

« Never use any power supply other than the standard power supply available in the country of
purchase. Using the incorrect voltage and frequency could cause afire or electric shock.

« Always push the plug all the way into the power outlet.

W Installing the Print Head

1 Plug the printer in.

2 Turn on the printer. Do NOT turn on the
computer yet.

The POWER lamp flashes and the printer beginsto
operate. Wait until the POWER lamp remains fully lit.

3 Open the front cover.

4 Remove the tape.

5 Raise the lock lever.

Do not touch internal parts other than the lock lever.




6 Remove the protective cap from the
print head.

= Notes print head electrical

« Do not touch the print nozzles
head nozzles or
electrical contacts.

« Do not attempt to
reattach the protective
cap onceit has been
removed.

print head print head holder

7 Place the print head in the holder.

= Note
Be careful not to touch any parts inside the printer.

8 Lock the print head into place by
lowering the lever.

Do not touch the lock lever once the print head has been
installed.

B Installing the Ink Tanks

* For safety reasons, store ink tanks out of the reach of small children.
1 Take out the magenta ink tank.

2 Pull the orange tape in the direction of
the arrow and remove the clear film.




protective cap 3 Hold the ink tank as shown in the
diagram and remove the protective cap.

= Notes ink port
« Do not squeeze the sides of y
the ink tanks as this may /
cause theink to leak out and ‘@ &]

stain your clothes and hands.
Do not touch the ink port.
Do not attempt to reattach the
protective cap once it has
been removed.

Insert the magenta ink tank into the
right-hand slot. Press the top until it
clicks into place.

Use the same procedure to install the
other ink tanks in their appropriate slots.

Check the labelsto make sure that each tank isin the
correct position.

= Notes

» Only install theink tanksin the positions specified
by the labels.

« If ink tanks are not installed in the right position,
colorswill not be printed correctly. Immediately
reinstall the tank in the correct position and carry
out print head cleaning. For details, refer to the
User’s Guide.

Cyan Photo Black Yellow Photo
Cyan Magenta

6 Close the front cover.

Wait until the POWER lamp remains fully lit (about 60
seconds).



4 Loading Paper

B Loading A4 (Letter) Size Plain Paper

paper thickness lever

output tray

1 Open the front cover.

2 Move the paper thickness lever at the

top of the print head holder to the left
position. Close the front cover.

= Note

Set the paper thickness lever to the left when using
plain paper, to the right when using thick paper.
Refer to the User’s Guide for information on loading
envelopes and other media

Pull out the paper rest and the output
tray as shown.

Load the paper, aligning it with the right
side of the sheet feeder.
You can load up to 150 sheets of plain paper. Do not

exceed thislimit. After printing, do not stack more than
50 sheetsin the paper outpt tray.

Press the paper guide and slide it
against the left side of the stack of

paper.

You now need to install the printer driver:
Windows: Go to page 8
Macintosh: Go to page 10




5 Installing the Printer Driver

B Installing the Printer Driver — Windows

= Notes
« Do not disconnect the cable or remove the CD-ROM during the installation. The driver cannot be

correctly installed.
« The screens below refer to Windows X P installation. Screen may differ depending on the operating

system you are using.
* When installing the printer driver in Windows XP or Windows 2000, log on to the system asa

member of the Administrator s group.

If the following screen appears automatically, click Cancel and follow steps 1 to 8 to install the printer
driver.

‘Welcome to the Found New
Hardware Wizard

This wizard helps you nstal software for

What do you want the wizaid o do?

st e 5o
Onstlliom

Clck Net o contiue.

Special Notes for Windows 98 or Windows Me USB Users
Click Cancel to quit the screen and turn off the printer. Next, remove and replace the USB cable
connected to your computer.

1 Ensure the printer and computer are
switched off.

2 Turn on the computer and start
Windows. If any applications
automatically run, quit them.

Disable any virus detection programs.
Do NOT turn the printer on at this stage.




3 Place the Setup Software & User’s
Guide CD-ROM in the CD-ROM drive.

= Notes
= . )
/ N~ A « |f the CD-ROM does not run automatically, click

Start and select My Computer, then double-click
the CD-ROM icon. For non-XP Windows, double-
click My Computer in the Windows screen, then
double-click the CD-ROM icon.

« If the language selection screen appears, select a
language, then click the OK button.

4 Follow the instructions displayed on
L - ! screen. When the screen shown on the
e left is displayed, click Install.

W; Install J )

5 When the screen shown on the left
appears, turn the printer on.

If the printer isrecognized, the printer driver will be
automatically installed.

= Note

If the connection is not recognized, refer to the
section “Notes on Handling the USB Interface (for
Windows Users)” on page 21.

Terminate Installation

Software installation is completed 6 CIle OK

Installation results are as follows.

Printer Driver Installed




Canof | <o

View Documents.

7

When the screen shown on the left
appears, click Exit.

Before you use the printer, you must carry out print head
alignment on page 12.

= Notes

» To view the User’s Guide, please refer to page 21.
« |If amessage prompting you to restart the
computer appears, click Yes.

B Installing the Printer Driver — Macintosh

= Notes

» Do not remove or insert the USB cable during installation, as this may result in the computer or
printer not operating normally.

» Beforeinstalling the driver, disable al virus detection programs and automatically loading
programs or remove them from your system folder.

5]
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Turn on the Mac.

Place the Setup Software & User’s
Guide CD-ROM in the CD-ROM drive.

Double-click the Mac OS 8.6-9.x folder.

Double-click the printer driver folder,
then select a language.

Double-click Installer.

Read the Licence Agreement and click
Accept to continue.



Easy Install E

a
c

41950 pi
#1950 printer profile

uter.

—

Htems willbe installed on the disk "E-system

Installation was successTul, You have installed
software which requires you to restart your
computer. Ifyou are finished, click Restart, or if you
wish to perform additional installations, click
Continue.

L= File Edit View Special [@ Help
About This Computer

PSONStatusMonitor 3

[, Favorites

Key Caps

Network Browser

[ Recent Applications

Il Recent Documents

& RecentServers

R Remote Access Status
| Scrapbook

[, screen snapz

& Sherlock 2

< Stickies

Chooser

Connected to :
1950 1

DT

S

@ Active
Q@ Inactive 7.6.2

AppleTalk

7 Click Install.
Wait for the installation to finish.

= Note

No other applications can be running during

0 this installation. Click Continue to
automatically quit all other running
applications. Click Cancel to leave your
disks untouched.

o)

If the above message appears, check that there are
no unsaved documents, then click the Continue
button. If a document needs to be saved, click
Cancel then save the document. After saving the
document, begin again from step 4.

8 Click Restart.
The computer restarts.

9 Select Chooser in the Apple Menu.

10 Click the icon for the printer you are
using and close Chooser.

Before you use the printer, you must carry out print head
alignment on page 14.

= Note

Refer to the User’s Guide when using this printer as
anetwork printer.

11



6 Aligning the Print Head

This operation must be carried out when using the printer for the first time. Aligning the print head positions
allows you to print without shiftsin the color registration.

B Aligning the Print Head — Windows

% Printers and Fexes 3
Canon 1950 X] 4
) This printer requires print head slignment.
. Click Print Head alignment on the Maintenance tab to start alignment.

12

Click Start and select Control Panel,
Printers and Other Hardware, and
then Printers and Faxes.

= Note

For non-XP Windows, click Sart, then select
Settings, Printers.

Click the icon for your printer.

Open the File menu and select:

* Windows X P/Windows 2000 —
[Printing Preferences...]
* Windows Me&/Windows 98 — [Properties]

to open the setting screen.

Click OK.

Click the Maintenance tab, and click
Print Head Alignment.

Check that paper is loaded in the printer
and click OK. If a message warning you
not to perform other operations
appears, click OK.



7 After the pattern is printed, click Yes.

© ) Didthe pattem prirt successfuly?
Y

IF nothing was print
again,

iF the pattern s noticsably faint or patchy, clckNo and try

If the pattern is not printed successfully, open the front
cover and ensure that the ink tanks are correctly

installed.
ol S M i 2 8 Look at the print-out. From the patterns
B e RN S e s in Column A, select the most even, least

irregular pattern and enter the number.

Horizontal Alignmert

Column & [
Column B o =
€ Column G o =
= Column b=
Column E. [o ==

Bi-directional Alignment -5 ta +5]

Column E: o0 =
Column G: 0=
Column H: o =

0K Cancel | Help ‘

Bint Haad Agamrant ] 9 Inthe same way, one by one, select the

e o bt most even patterns printed with the
least irregularities from each of
ot Amrent (31 17)_ Columns B to H, enter their numbers,

Column &

and click OK.

If itisdifficult to pick the best pattern on Column H,
pick the setting that producesthe least noticeabl e vertical
white stripes.

Less noticeable More noticeable
white stripes white stripes

Column B
Column .
Column D:

Column E

Canon i950 _ 10 Click OK.

\ij) i ) et s e et This completes the printer setup. The printer is now

ready to use.

13



B Aligning the Print Head — Macintosh

canon 950 Version 41

Canon 950 Printer Utility Version 4.1

B Nozzle Check
Prints a nozzle-check pattern.

Print Head Alignment
it will align the print heads to correct any
error in their installation position.

Print head alignment is being executed.
Alignment entails printing, so do the
following: Ready the printer (connect the
cable and turn the power on), move the
printer's paper thickness lever to the left,
and load a sheet of plain paper in the sheet
feeder. Do you want to print head alignment
patterns?

()

Print Head Alignment

Print head alignment is being executed. Referring to the patterns
printed in columns Ato H, select the pattern that shows no flaws.

Adjust sideways (-3

-
= Column B:
= Column C:
= Column D
Column E:

Adjust both ways(-5~+5)
Column F:

Column G:

Column H:

=

14

1 Select Page Setup in the File Menu.
2 Click Utilities.

3 Select Test Print from the menu and
click Print Head Alignment.

4 Check that paper is loaded in the printer
and click OK.

If the pattern is not printed successfully, open the front
cover and ensure that the ink tanks are correctly
installed.

5 Look at the print-out. From the patterns
in Column A, select the most even, least
irregular pattern and enter the number.



Print Head Alignment

Print head alignment is being executed. Referring to the patterns
printed in columns A to H,select the pattern that shows no flaws.

Adjust sideways(-3~+7)

ColumnA:
ColumnB:
ColumnC:
ColumnD:

ColumnE:

ColumnF:
Column 6:

ColumnH:

Canon i950Printer Utility Version 41
TestPrint B
g testecnecx
Prints a nozzle-check pattern.
cor y
ition
Canoni950 nad
L x ]

6 In the same way, one by one, select the

most even patterns printed with the
least irregularities from each of
Columns B to H, enter their numbers
and click Send.

If itisdifficult to pick the best pattern on Column H,
pick the setting that producesthe least noticeabl e vertical
white stripes.

Less noticeable More noticeable
white stripes white stripes

7 Click Close.

8 Click OK.

This completes the printer setup. The printer is now

ready to use.

15



Basic Operations

« |If you detect smoke, unusual smells or strange noises around the printer, immediately switch the
printer off and always unplug the printer. Contact your local Canon service representative.
« To avoid injury, never put your hand or fingersinside the printer whileit is printing.

Printing with Windows

Adjusting the print settings according to your needs allows you to produce better quality prints.
Inthis section, we will use WordPad for the purpose of explanation. The procedures you use and the screens
that appear on your computer may differ according to the application that you use.

B Printing
1 Print the document from the application.
e On the File menu, click Print.
Saveiis. Pt Check the gpplication’s users manua for the actual
I — procedures.
p—y i
& prn PI% 2 Ensure your printer is selected, then

General CIICk:
elect Piinter

¢ Windows XP — [Preferences]
» Windows Me/Windows 98 — [Properties]
* Windows 2000 — [Main] tab

3 Specify the required settings and click
OK.

= Note

If you use anything other than plain paper, please
refer to “Basic Print Settings’ on page 17.

4 To start printing, click Print.

Printing will start in afew moments.

16



B Basic Print Settings

For the best print quality, specify the minimum requirement settingsin the Main tab. To get the best
results, ensure you select the type of medialoaded in the printer when printing on paper other than plain

paper.

2 Printing Preferences

&) Main | £ Page Setup | @] Stamp/Background | o# Effects | (5 Profiles | fi§ Maintenance

BE (6)

Media Type ( Plsin Papsr 3 )— Q)

Paper Source: ‘Auta Sheet Feeder v

~N

() Standard 2
O Diaft ( )
() Custom

J
Color Adjustment: () Auta
= —o

[] Grawssale Printing

Print Quality

[ Preview before printing

4)

[ ok J[ cancel ([ ten

—0)

)

(1) Media Type

Select the type of media loaded in the printer.

(2) Print Quality

Select one option from High, Standard and Draft. Select Custom to
set the print quality manually.

(3) Color Adjustment

If you wish to control the color adjustment settings in more detail,
select Manual.

(4) Preview before printing

Select this to check the layout before printing.

(5) Help

Click this for a more detailed explanation of the functions in the tab.
(This may not appear when using Windows XP or Windows 2000. If
this happens, click Start then select All Programs (or Programs) -
Canon i950 - Guide).

(6)?

Click this to change the cursor shape to ?. By clicking on the item’s
name with this ? cursor, an explanation will be displayed.

= Notes

* Clicking the Print Advisor allows you to change to the most appropriate print settings simply by
answering questions when prompted.

» Usethe application to set the paper size and paper orientation. Before printing, open the settings
screen and check that the Page Size in the Page Setup tab is the same as that specified within

application.

* Refer to the User’s Guide for more information about printer driver functionality.

17



Printing with Macintosh

Adjusting the print settings according to your needs allows you to produce better quality prints.

B Printing
- Edit _Font Size Sty 1 Open the Page Setup dialog box in

Il new N your application.
Elose :‘s'\' On the File menu, click Page Setup. Check the
cave As.. application’s users manual for the actual procedures.
Print.. 8P
Print One Copy
Quit #0Q

Canoniza e p— 2 Specify the page setup,

‘_ For detalls, refer to “Page Setup” on page 19.

@ mmt font Size Style So 3 Open the Print dialog box in your
|| N

e E application to print the document.
| pen...

Close =W On the File menu, click Print. Check the application’s

SEVE users manual for the actual procedures.
Save As...

Page Setup...
Print... *#P
Print One Copy'

Quit #0Q

4 Specify the print settings according to
your requirements.

For details, refer to “Basic Print Settings’ on page 19.

5 Click Print.

Printing will start in afew moments.

18



B Page Setup

Use the Page Setup diaog box to specify the paper size settings.

Canonioso

Scale:

Orientation:

Height :267.0mm  Width: 210.0mm

[ Save Settings

Version 4.1
o< |
paper size {(A4 E — Select paper size
[ Banner Printing you wish to use.
[J Borderless Printing
Amount of Extension :
Min. e Max.

B Basic Print Settings

For the best print quality, specify the minimum requirement settingsin the Print dialog box. To get the
best results, ensure you select the type of medialoaded in the printer when printing on paper other than

plain paper.

Version4.] ,————
= G H—®)
Copies:
el
Pages: @ All -
@ From I:l To l:l
BJ Cartridge :
Sy [Photo B
&= il Media Type :
-7-7-_7 ‘ Plain Paper i])i— (1)
Z s Paper Source :
m [Autu Feeder ij
Print Mode :
Normal-size printing
[ Grayscale Printing

(1) Media Type

Select the type of media loaded in the printer.

(2) Print Mode

Manual and click Details.

Select the type of document you want to print.
To specify more detailed settings for the print quality or color, select

(3) Print

Click this to start printing.

= Notes

* See Balloon Help for more information about other printer driver functions.
Select Show Balloonsin the Help menu for an explanation of each of the itemsin the setting
screen. To see the explanation, point to the item with the mouse.

* Refer to the User’s Guide for more information about printer driver functionality.

19



Print Head Maintenance

B If Blurring Occurs or If a Specific Color Does Not Print

Perform print head cleaning to improve the print qudity. Ensure that the printer is turned on and follow
theinstructions below.

* Windows
Open the printer driver settings screen and click the Maintenance tab. Click Cleaning.
See page 12 for details on how to open the setting screen.

* Macintosh
Open the Page Setup dialog box and click Utilities. Click Cleaning.

B When the Printer Runs out of Ink

Replace the empty ink tank with a new one.
Specify the following ink tanks when purchasing.

Magenta BCI-6M

Photo Magenta BCI-6PM Photo
Yellow BCI-6Y

Black BCI-6BK

Photo Cyan BCI-6PC Photo
Cyan BCI-6C

1 Open the front cover and remove the
empty ink tank.

Do not touch the lock lever.

2 Install the new ink tank.

Close the front cover when finished.

= Note

For more details about maintenance, refer to the
User’'s Guide.




Notes on Handling the USB Interface (for Windows Users)

If installation of the printer driver does not proceed as instructed in this Quick Start Guide, there may be a
problem with the USB driver instdlation.
Try reinstalling the printer driver.

B Reinstalling
If you cannot proceed beyond the Printer Port screen:

Click Cancel.

When the Terminate Installation screen is
displayed, click OK.

Click Exit, then remove the CD-ROM.
Turn the printer off.

Follow ths procedure.
1.Check that the cable is connected.

2Tun

Restart the computer.

AU AW N

Reinstall the printer driver (see page 8).

For Further Details...

For more information, place the Setup Software & User’s Guide CD-ROM in the CD-ROM drive.

B User’s Guide Contents

The“User’'s Guide” isHTML manual you can browse through on your computer.

Contents

* Printer parts and their functions  Printing media
* Further printing techniques  Troubleshooting
* Routine maintenance  Specifications

B How to View the User’'s Guide

For Windows For Macintosh

(1) Load the CD-ROM inyour computer. (1) Load the CD-ROM in your computer.

(2) Click Documentation at |eft of the screen. (2) Double-click the Manual folder.

(3) Click View Documents. (3) Select alanguagefolder.

(4) When amessage appears, click (4) Double-click the User’s Guide folder.
* Yes—toingstall the User's Guide (5) Double-click theiconfor thei950_UG_UK.htm
* No-only to browse the User’s Guide file

(5) Sdect User’s Guideand click OK.
Follow the instructions on screen.

21



B BJ Printer Driver Systems Requirements

For Windows

» Use acomputer on which Windows XP, Windows 2000, Windows Me or Windows 98 can
operate.

* USB* interface

 Availablc hard-disk space for printer driver installation

Windows X P/Windows 2000 : 50MB
Windows Me/Windows 98 : 15MB

* USB operation can only be guaranteed on a PC with pre-installed Windows XP, Windows
2000, Windows Me, or Windows 98. (Thisincludes Windows X P, Windows 2000 or Windows
Me upgraded from pre-installed Windows 98 or |ater)

For Macintosh

» Use aMacintosh series computer equipped with USB interface on which Mac OS 8.6-9.x can
operate.

» 30MB of available hard-disk space for printer driver installation

Additional Systems Requirementsfor User’s Guide

« Pentium® 75 MHz equivalent or higher processor (Pentium® 133MHz equivalent or higher
processor recommended)

» 2x or higher CD-ROM drive (4x or higher recommended)

* 10 MB of available hard-disk space (when installing the User’s Guide)

« Microsoft Internet Explorer 5.0 or later

22
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